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I. Overview 
 

Poly(methyl methacrylate), known commonly as acrylic, is a transparent thermoplastic polymer. 
Acrylic is a choice material for laser cutting due to the ease with which it is machined. 
 
Some desirable qualities of PMMA include high light transmission and the aesthetic appeal of 
transparency. PMMA is widely used for illuminated as well as non-illuminated display signs. 
Trophies and memorabilia often use cast acrylic as the base material due to the high visual 
contrast produced by engraving the material. Furthermore, acrylic is often used as a 
shatterproof glass substitute. It is more weather resistant than other plastics as polystyrene and 
polyethylene and therefore often found in outdoor applications. 

II. Manufacturing Process 
 

Two manufacturing techniques segregate the main types of acrylic: casting and polymer 
extrusion. Variations of acrylic, as mirrored or colored plastics, are becoming more accessible 
and popular as well. 

Cast Acrylic 
Cast acrylic is manufactured by pouring the polymer into a casting cell which consists of two 
glass sheets between which a rubber gasket is placed to determine the thickness of the final 
sheet. The cell is completely filled with acrylic resin which is then clamped together to ensure an 
even pressure across the sheet as the material polymerizes and shrinks. The cell is then taken 
through a heating cycle and is possibly annealed to reduce internal stresses.  Due to the 
fabrication process, the tolerance in thickness of a cast sheet varies greater than extruded 
acrylic. It is also more expensive to make. However, cast acrylic has reduced residual stresses 
and therefore greater resistance to cracking when compared to its extruded counterpart. 

Extruded Acrylic 
Extruded acrylic is manufactured by melting acrylic resin pellets and squeezing the melted 
material through a die into a molten sheet whose thickness is determined by the spacing of the 
die. The molten sheets then pass through a set of cooling rolls where it is post-processed.  As a 



result of this manufacturing process, extruded acrylic is more even in thickness, is faster to 
manufacture, and cheaper to purchase than cast acrylic. 

III. Material Specifications 
 

There are various standards for the specification of PMMA plastic sheet. The ASTM D4802-10 
and ISO 7823-1:2003 are two common standards.  

ASTM provides four major categories for the specification of acrylic sheets (ASTM International). 
A summary of the four are provided below. 

Category A-1: Cell-cast PMMA sheets that represent the best optical quality and are 
characterized by the highest long-term stress and chemical resistance. 

Category A-2: PMMA sheets manufactured by the continuous-casting method which has better 
thickness control than Category A-1, but lower optical quality.  

Category B-1: PMMA sheets from a variety of manufacturing methods. Possesses lower 
chemical, heat, and stress-craze resistance than the A Categories, but generally has better 
optical qualities and thickness control than A-2.   

Category B-2: Extruded PMMA sheets which excellent thickness control but reduced long-term 
stress, chemical resistance, optical quality, and thermal stability.  

Depending on the application, you may want to select an acrylic sheet for its optical quality, 
weather resistance, and/or thickness specifications if tight tolerances are to be met. 

IV. Material composition and impact on mechanical properties 
 

Poly(methyl methacrylate) is derived from the polymerization of methyl acrylate. Its monomer is 
a mobile liquid with a characteristic sweet odor. 

 

Figure 1 Polymerization of poly(methyl methacrylate) from methyl methacrylate. The final monomer is shown on 
the right. (Polymer Science Learning Center, Department of Polymer Science, University of Southern Mississippi) 



 

Most commercial acrylics are amorphous, linear polymers with a wide range of molecular 
weights. The difference in molecular weight determines the amount of entanglement of 
polymer chains; a high molecular weight contributes to extensive chain entanglement and 
therefore a more rigid material. However, the syndiotactic nature of acrylic polymers 
(orientation of side chains are alternating in space) does not enable the polymers chains to pack 
so closely as to form a crystalline material.    

 

Figure 2 Block diagram of syndiotactic orientation of monomers in PMMA chain. 

Manufacturing variations between cast and extruded acrylics result in sheets with different 
mechanical properties. Casting produces a homogenous (polymer chain orientation is random) 
material with similar properties in all directions. On the other hand, extrusion aligns polymer 
chains, resulting in a heterogeneous sheet with properties which vary depending on the 
extrusion direction. The polymer is often stronger in the direction parallel to the molecular 
orientation. When cast acrylic is annealed in its heating cycle, it reduces the amount of residual 
stresses in the polymer as compared to its extruded counterpart. There is often more tension in 
extruded acrylic which causes it to be more prone to brittle fracture.  

PMMA also has a 92% transmissivity of light, giving it its transparent quality even in great 
thicknesses. The polymer is not very chemically resistant.  Aliphatic alcohols can cause crazing 
and cracking of PMMA. 

V. Material removal mechanism 
 

Acrylic is laser machined via material vaporization. This is in contrast to most other 
thermoplastics which are cut by melt shearing due to acrylic’s relatively low vaporization point. 
When heated above the glass transition temperature (about 100°C), PMMA becomes rubbery, a 
state which extends for about 60°C. Raising the temperature above this point causes 
decomposition. 

According to FTIR analysis of cast and extruded acrylic samples purchased from McMaster-Carr, 
the material is very absorptive of the 10.6 micrometer CO2 laser wavelength. Combined with the 
low vaporization temperature of acrylic, the material is able to go from a solid to gaseous phase 



upon laser heating. This is highly beneficial in regard to laser machining because it results in 
higher precision parts with a small laser kerf. 

 

Figure 3 FTIR analysis of cast acrylic from McMaster-Carr showing high absorbance at 10.6 micrometers (940 cm-1). 
(Bio-Rad Laboratories, Inc.) 

 

Figure 4 TGA analysis of cast acrylic places its degradation temperature at about 322.62°C. Extruded acrylic is 
vaporized at a slightly higher temperature (~340°C). 



 

Figure 5 The polymer structure of both cast and extruded acrylic both contain a characteristic C-O bond which is 
highly absorptive of the 10.6 micrometer laser wavelength. This C-O bond serves as a bucket, collecting heat that 
the laser inputs into the system. The material directly affected by the laser is then able to rise to its vaporization 

temperature to be removed. 

PMMA is initially synthesized from a free radical polymerization of the monomer methyl 
methacrylate. Upon heating, the molecules of the amorphous polymer start to rearrange 
continuously, and then the backbone of the linear polymer begins to degrade (molecular 
scission). Thermal degradation of PMMA at about 300-400⁰C is most likely due to 
depolymerization of the chain from a free radical reaction.  When PMMA is laser machined via 
vaporization, it gives off a distinctive smell which is attributed to the vapors of methyl 
methacrylate, monomers generated by the molecular scission. Please refer to “Thermal 
Degradation of PMMA” by Zen Ziyan for a more in-depth look at the thermal degradation 
process of PMMA.  

VI. Techniques 

Trade Secrets: Vector Cutting Extruded Acrylic 
Some of the generic masking films that acrylic comes with contain paraffin (a wax) which can 
contribute to excessive flare-ups and distortion of the material when laser cutting. Therefore, to 
be safe, it is often better to remove the film and re-mask with your own artist’s or tack tape. 

Flashback is when excess laser energy reflects off of the cutting bed onto the underside of the 
stock, resulting in undesired markings or distortions. Change the cutting bed to either a 
honeycomb or aluminum lamella bed in order to allow the beam energy to pass through the 
empty spaces. If a change in the cutting bed is not enough to avoid flashback, the acrylic sheet 
can be raised off of the laser bed before cutting. The beam will then pass through entirely 
without reflection.  

Often, the desired finish on an extruded acrylic cut edge is a glossy and nearly flame-polished 
look which is a result of melt generated by the heat of the laser resolidifying on the side of the 
material. As a general rule of thumb, shorter, higher-powered pulses of the laser beam (high 
frequency + high power combination) allow the acrylic to reach its vaporization point in a 
shorter period of time as opposed to merely melting.  A note on the polished edge: although it is 



aesthetically pleasing, a polished edge damages the material’s mechanical integrity. The 
resolidification of melt along the cut edge contributes to residual stresses, traps microscopic air 
bubbles, and makes the piece more prone to cracking.    

When laser machining very thick acrylic or performing very intricate cuts, it is often easy to heat 
distort the material as the power is raised to cut through the thicker material or the nearby 
acrylic is not given enough time to cool down in the case of adjacent, intricate vector cuts. 
Create a heat sink for the material by masking both sides of the acrylic with transfer tape and 
lightly dampening the masking with a spray bottle. Be careful not to leave ‘puddles’ of water on 
the material as they can severely reduce cutting depth.  

Trade Secrets: Engraving Cast Acrylic 
Engraving acrylic on the underside of the material allows the image to be seen through the 
thickness of the piece. Mirror your graphic in your cut file to produce the correct final engraving.  

When engraving graphics which span large areas, the fine, horizontal lines of engraving can 
cause the final image to look coarse. Lower the laser bed, and shift the piece from the optimum 
focus level by just the slightest bit so that the spot size of the laser is increased and the raster 
strokes are overlapping to achieve a smoother, blending effect. 

 

 

Figure 6 Engraved cast acrylic provides a unique, frosted image contrast. Shadows cast by the engraving are very 
distinct and sharp representations of the original image. 



Trade Secrets: Engraving Mirrored Acrylic 
Single surface mirrored acrylics come with a reflective side and an opaque backing on the 
opposite surface. When engraving mirrored acrylic, a double image will occur if engraving on the 
reflective surface (you can engrave on the back side instead). When vector cutting mirrored 
acrylic, cut with the mirrored surface up and don’t worry about the laser reflecting off of the 
material because it will be absorbed by the acrylic first.  

Some Warning about Finishing Acrylic 
Never clean acrylic with paper towels because they will grate the material like sandpaper, 
reducing its transparency and giving it a grainy texture. Also, alcohol or ammonia-based cleaners 
will cause acrylic that has been cut with a polished edge to crack along the surface.  

VII. Acrylic Sources 
 

Clear, colored, and mirrored cast acrylic sheets can be purchased on McMaster-Carr in a variety 
of sizes. Perspex by Lucite International is another high-quality, albeit expensive brand of cast 
and extruded acrylics. Plaskolite, Inc. produces a variety of extruded acrylic sheets. J. Freeman, 
Inc. is a local source for bulk quantities of extruded acrylic. 

VIII. Appendix 
 

Following are images taken on an optical microscope at 5x magnification of raster engraved and 
vector-cut surfaces of cast and extruded PMMA.  

Raster (L) & Vector (R) Surfaces of Cast Acrylic 

 



Raster (L) & Vector (R) Surfaces of Extruded Acrylic 
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EXECUTIVE SUMMARY 

The goal of this project was to determine how polymer thermal properties determine the surface finish of a laser 
cut part.  The laser system used was a 60W Epilog Helix, a hobbyist-grade CO2 laser delivering a monochromatic 
wavelength of 10.6 micrometers (wavenumber: 940 cm-1). We explored five thermoplastics: polyacetal 
homopolymer (Delrin), cast polymethyl methacrylate (C-PMMA), extruded polymethyl methacrylate (X-PMMA), 
isotactic polypropylene (PP), and high density polyethylene (HPDE). Throughout the project, we ran samples of 
each unprocessed material through the Fourier transform infrared spectrometer (FTIR), thermogravimetric 
analysis machine (TGA) and differential scanning calorimeter (DSC) to learn about their thermal properties. We 
also examined the cut surface of the materials after laser processing at settings suggested by the laser cutter 
manual. In our explorations, we determined that the materials with a C-O group, lower heat capacity, lower 
thermal conductivity, and a degradation point below 400⁰C (Delrin, C-PMMA, X-PMMA) tend have a smoother cut 
surface when laser processed with a 60 W laser. These materials tend to be laser cut via vaporization. Materials 
that do not fit this profile (PP and HDPE) tend to have greater melt zones, resulting in cut parts that are both 
smaller than and possess greater variations in shape from the specifications. They are less suited for processing 
with a 60 W laser. For the future, we suggest exploration of the heat-affected zones of the material and properties 
of the resolidified melt that inevitably results from laser processing. We also advise acquisition of another 
thermoplastic with C-O bonds in order to compare its cut mechanism with both PMMA and Delrin.  

LASER PROCESSING 

Laser processing is a digital manufacturing method that uses lasers to cut, etch, engrave or mark parts from a sheet 
of stock material. The first commercially-available CO2 laser cutters that resemble those available today were sold 
by Laser World AG of Switzerland in 1975 to cut holes in cow bells. Laser cutters are now cheaper and available to 
the public in lower power forms. Laser cutters exert minimal stress on the sheet of material (as compared to a 
blade) and do not need to be clamped (reducing distortion during manufacture). The narrow kerf width allows for 
reproduction of intricate parts with extreme ease at low to no labor cost. Cut parts are extremely accurate and 
have a high quality edge finish. 

Thermoplastics are materials that become pliable above a specific temperature but return to a solid state after 
cooling. This process is repeatable and reversible. When laser processing, a thermoplastic can be cut via 
vaporization (the material is vaporized into gas and then sucked away via the air filter and air assist associated with 
the laser cutter), melt shearing (the material melts into molten plastic that is blown away with air assist), or 
chemical degradation (the material is degraded to carbon smoke which is sucked away via the air filter and air 
assist). 

In Figure 1, the laser processing mechanism for thermoplastics is outlined.  
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Figure 1 Laser machining process of thermoplastic polymers. 

BRIEF DISCUSSION OF MATERIAL PROPERTIES 

POLYACETAL HOMOPOLYMER (DELRIN) 

 

Figure 2 Polyoxymethylene is formed by polymerizing pure formaldehyde.  
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Figure 3 Polymer chain of delrin. 

Our FTIR comparison with the MatWeb data indicates that our material is polyacetal. We know we ordered Delrin 
from our supplier so our test confirms the McMaster-Carr order. Delrin is a polyoxymethylene homopolymer 
owned by DuPont. Polyoxymethylene is formed by polymerizing extremely pure formaldehyde. The process for 
creating Delrin was researched extensively to create a material that is tough and stable. Four processes are known 
to degrade Delrin: 

1. Stepwise thermal- or base-catalysed hydrolytic depolymerisation (cleavage of polymers by the 
introduction of water) 

2. Oxidative attack leading to chain scission and therefore depolymerization (forceful introduction of oxygen 
atoms) 

3. Acid-catalysed cleavage of C-O bond 
4. Thermal depolymerization via scission of the C-O bond occurring above 270⁰C 

Based on what we know about laser processing, we anticipate that thermal depolymerization of of the C-O bonds 
will occur when laser cutting the material. Delrin forms a linear, flexible chain backbone with little to no branching. 
It is therefore highly crystalline (75-85%) and pack closely together with a melting point at 175⁰C. Delrin needs to 
be capped with end groups acetate or methoxyl. Sheets of Delrin are generally produced via extrusion. 
 

POLYMETHYL METHACRYLATE 

 

Figure 4 Methyl methacrylate monomer of PMMA. 
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Figure 5 Block diagram of syndiotactic orientation of monomers in PMMA chain. 

PMMA is an amorphous, linear polymer of the acrylic class. Running our sample of X-PMMA through the FTIR 
confirmed our possession of 85% syndiotactic polymethyl methacrylate.  Syndiotacticity refers to the alternate 
positions of molecular groups along the polymer chain.  

PMMA is synthesized from a free radical polymerization of the monomer methyl methacrylate. Upon heating, the 
molecules of the amorphous polymer start to rearrange continuously and then the backbone of the linear polymer 
begins to degrade (molecular scission). Thermal degradation of PMMA at about 300-400⁰C is due to 
depolymerization of the chain from a free radical reaction.  When PMMA is laser machined, it gives off a distinctive 
smell which is attributed to the vapors of methyl methacrylate, monomers generated by the molecular scission.  

EXTRUDED POLYMETHYL METHACRYLATE (X-PMMA) 

X-PMMA is manufactured by squeezing acrylic resin through a die of a certain thickness in order to produce molten 
sheets. These sheets are then run through cooling rollers. As a result of the manufacturing process, X-PMMA has 
an apparent extrusion direction which aligns molecular chains in a common orientation. This then allows 
secondary forces to play a greater part between the interactions of the syndiotactic chains. This contributes to the 
higher degradation temperature of X-PMMA in comparison to C-PMMA. Extruded sheets also have less variation in 
thickness across due to the manufacturing process.  

CAST POLYMETHYL METHACRYLATE (C-PMMA) 

The process of casting acrylic consists of pouring the polymer into a casting cell which consists of two glass sheets 
separated by a gasket. The cell is then clamped together as the material is allowed to polymerize and shrink. Then, 
the material can be annealed to reduce internal stresses. Annealing gives C-PMMA generally better mechanical 
properties than X-PMMA. However, due to cell casting, the resultant sheet varies more in thickness across than 
similar extruded sheets. 

POLYPROPYLENE (PP) 

According to MatWeb, our FTIR data confirms that the material we received is isotactic polypropylene. 
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Figure 6 FTIR absorption spectrum for isotactic polypropylene.  

The red data is from the MatWeb database and the black data is from the FTIR data we collected. As can be seen, 
the correlation is nearly identical. 

Isotactic refers to the stereoisomerism of the molecules. An isotactic configuration involves the zig-zag pattern of 
the carbon chain atoms. In the case of PP, it is important to note the 3D nature of its isotactic form where propene 
monomers form a hydrocarbon isotactic chain (see Figure 5). Because the material is isotactic, it is better able to 
stack itself and form Van der Waal bonds, making the melting point higher (160⁰C). 

 

Figure 7 Isotactic polypropylene chain. 

Polypropylene is a formed by separating propylene molecules from propane (a petroleum product). The propylene 
molecules are then polymerized to create various stereoisometric formations of the material within one vessel. 
The types are separated and processed further to get the purest product. 

Polypropylene crystallises in a regular helix formed from linear chains. Polypropylene can be easily degraded 
through photo-oxidation through UV radiation . UV rays have a wavelength 400-100 nm so we anticipate that that 
the laser’s IR rays will not be as significant as Delrin. 
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ABSORPTION OF CO2 LASER WAVELENGTH 

 

Figure 8 Close-up of FTIR absorption spectrum of Delrin, C-PMMA, X-PMMA, PP and HDPE about the CO2 laser wavelength. The 10.6 
micrometer CO2 wavelength translates to a wavenumber of 940 cm-1. An extinction unit of 0 corresponds to light travelling through the 
material without loss while a value greater than 0 corresponds to light absorption. It can be seen here that the absorption of CO2 laser 

radiation is greatest in Delrin, and then consecutively in C-PMMA, X-PMMA, PP and HDPE which inversely correlates with the quality of cuts 
that we were able to make on each material.  
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POLYMER STRUCTURE 

 

Delrin: The polymer structure of polyoxymethylene shows a simple, repeating 
carbon-oxygen backbone. It is this C-O bond which is highly absorptive of 
frequencies about the range of the laser cutter (~970-1250 cm-1). The C-O bond 
stretches when hit with the laser, absorbing heat. It takes more energy to stretch 
than bend a bond. Therefore, stretching vibration results in significant heating of the 
laser processed area.  

 

Figure 9 Delrin is known to form formaldehyde upon laser treatment. INGRID CITE THIS AND ADD MORE TO IT 
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PMMA: The polymer structure of both cast and extruded acrylic also 
contain the characteristic C-O bond found in Delrin. PMMA and Delrin 
respond to laser machining in extremely similar ways: they are two of 
the few materials known to laser machine via vaporization. We believe 
that it is this C-O bond which serves as a bucket, collecting heat that 
the laser inputs into the system. The material directly affected by the 
laser is then able to be raised to its vaporization temperature to be 
removed.  

 

PP: The polymer structure of polypropylene does not possess a C-O bond, 
making the absorption of frequencies about the range of the laser cutter 
(~970-1250 cm-1) more diffuse. Heat absorption is less focused in the laser 
processing area. As a result, the material does not heat up enough to 
create a distinct zone of high energy density.  This material is known to be 
cut by melt shearing and analysis of the molecular structure supports this 
claim. To achieve melt shearing however, the material needs only to be 
heated to its melt temperature (160⁰C). 

 

HDPE: Similar to PP, the polymer structure of polypropylene does not 
possess a C-O bond making the absorption of frequencies about the range 
of the laser cutter (~970-1250 cm-1) more diffuse.  HDPE has a relatively 
low melt temperature compared to the other plastics due to having low 
intermolecular forces, but a high degradation temperature.  As a result, 
this material cuts by melt shearing. 

DEGRADATION PROPERTIES (TGA) 

Running thermogravimetric analysis of samples of each material rendered the following results: 
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As can be seen, the materials with the degradation points below 400⁰C are Delrin, C-PMMA, and X-PMMA, are all 
materials that are known to cut by vaporization. Materials with a degradation points above 400⁰C (HDPE and PP) 
are the materials known to cut by melt shearing. This proves to be an extremely powerful predictor of whether a 
material will cut well or poorly. Note that this is not the sole factor that determines laserability - the absorbance, 
thermal conductivity and heat capacity all interact to produce a certain cut surface.  

 

THERMAL CONDUCTIVITY AND HEAT CAPACITY 

Materials that are easier to degrade are cut more easily than materials that are more difficult to degrade.  
Vaporisation cutting also leaves a better surface finish, and minimizes the warping of the part.  While the 
degradation temperature observed in our TGA analysis is the driving factor, other thermal properties change how 
the material cuts.  We quantified through the “heat capacity per volume” and “heat required to heat 1 cm3 to 
degradation temperature”. 

The heat capacity per volume is signifies the amount of energy the laser needs to dump into the materials to raise 
1 cm3 1 degree kelvin.  Normally this is described as heat per gram kelvin, but since the laser beam has a constant 
cross section, it makes more sense to talk about volume as opposed to mass being removed.  This is especially 
important because these plastics do not have identical densities.  As you can see in the table, POM and HDPE have 
similar heat capacity per volume, while PP and PMMA have lower heat capacities for per volume. 
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This implies that POM should cut like HDPE, which we have observed to be not true.  This is because we have not 
taken into account the degradation temperature that needs to be reached for each material.  This is done by taking 
the degradation temperature and multiplying by the heat capacity per volume yielding the heat required to raise 
one cm3 to the degradation temperature.  This is the critical parameter along with laser wavelength absorbance 
that determines how a material will cut.  Looking at this parameter we see that materials with lower required 
energy to raise a volume to the degradation temperature cut by vaporization. 

Thermal conductivity has an influence on cut as well.  High thermal conductivity means that heat will diffuse across 
the part quickly, and that it will take even more energy to heat the cut zone.  The only material with a higher 
conductivity is HDPE, which explains the particularly wide kerf that was observed in that part, which was probably 
caused by a very wide heated area being sheared by the air.  It was wider than the cut in the PP probably because 
of HDPEs higher thermal conductivity and lower melt temperature. 

CULMINATION OF ABSORBANCE, THERMAL CONDUCTIVITY, AND HEAT CAPACITY 

 
 

POM PP X-PMMA C-PMMA HDPE 

 
 

Absorbance at 939 cm-1 (ranked) #1 

 
 

#4 #3 #2 #5 

Thermal conductivity (W/mK) .23-.37 .1-.22 .2 .2 .42-.51 

Melt temperature (C) 175 160 160 160 121 

Heat capacity per volume (J/Kcm3)* 2.1 1.62 1.652 1.652 2.09 

Degradation Temperature (C) 321 433 347 322 474 

Heat required for 1cm3 to reach degradation temp (J) 674 701.46 573.44 531.94 990 

*Heat capacity per volume is calculated from the specific heat (J/gK) and density(g/cm3) of the polymers.  Volume 
(as opposed to mass) is more representative of the energy required to remove material as seen as the volume 
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under the laser. 
 

To culminate the thermal knowledge gained, a clear connection can be made between the laserability and a 
degradation temperature that is lower than 400⁰C. The materials all had relatively similar specific heats. The 
materials all have a specific heat that can then be extrapolated to the value in the final row of Table 1. This row 
demonstrates the heat required to make 1 cm3 reach its degradation temperature (J). Note that the order of 
increasing heat corresponds loosely to the material’s laserability in ascending order. 
 

The thermal conductivity of the materials were fairly close together (~0.2 W/mK) except that of HDPE with a 
thermal conductivity of 0.42-0.51 W/mK. This difference may account for the enormous melt zone seen in the 
microscopy. 

CUT SURFACE IMAGING 

 

Figure 10 C-PMMA: face of cut edge 

 

Figure 11 C-PMMA: top surface 
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In Figure 8, the striations made by the laser pulsing on and off are apparent.  Note that the piece has no “grain”.  
On the same image, horizontal ripples of decreasing frequency can be seen going from the top to bottom surface 
which is in contact with the laser bed. The laser is focused on the surface of the material while cutting, generating 
the highest energy density at that location. Due to the location of the focus and the relatively low thermal 
conductivity of C-PMMA, the horizontal ripples can be attributed to the temperature gradient down the cut edge 
and the resulting differences in thickness of material removed.  Since the top of the acrylic is in focus throughout 
the frame, it can be determined that the piece remained relatively flat and the heat affected zone was not 
extensive. From Figure 9, it can be seen that the cut edges are not entirely parallel. This taper is in part due to the 
focus location. 

 

Figure 12 X-PMMA: face of cut edge 

 

Figure 13 X-PMMA: top surface 

The X-PMMA was cut with the same settings as the C-PMMA. However, more melt can be seen on the cut edge of 
X-PMMA. It is easier to flame polish X-PMMA. This may be attributable to the higher molecular orientation from 
extrusion. Amorphous C-PMMA is has more entangled linear chains which may deter its ability to be flame 
polished. The “grain” pattern in Figure 10 is a manifestation of molecular alignment along the extrusion direction. 
In Figure 11, there is a definite fold or bump at the top edge of the plastic.  This only occurred on two of the four 
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sides of the piece, and is probably related to the direction that the air assist blows.  It appears to have been 
formed by melting, or at least passing the glass transition temperature, and then being deformed by the force of 
the air.  

 

Figure 14 HDPE: face of cut surface 

 

Figure 15 HDPE: top surface 
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The HDPE images (Figure 12 and 13) demonstrate that the part was incredibly warped by the heat of the laser 
cutting.  The left image is of one of the cut surfaces, and the right image is of the top of the piece. It can be noted 
that this is little difference between the two images as the whole part basically became molten and then re-
solidified. The melt temperature for HDPE is 121⁰C which is significantly lower than 474⁰C. The laser cannot supply 
the necessary energy to vaporize the material, therefore it makes sense that the material is cut with melt shearing. 
Unfortunately, the whole part tends to melt as well as the edges, making the quality of the part non-existent and 
the cut surface a melted mess. 

 

Figure 16 PP: top surface 

 

Figure 17 Delrin: top surface 

Here is a comparison of PP (Figure 16) and Delrin (Figure 17) edges.  The PP edge is severely melted and the lip 
created by the melt is folded over the piece, creating a rounded corner and a round edge profile.  The Delrin edge 
is fairly straight with some divots, but the surface is not melted or rounded.  This is because Delrin vaporizes, while 
PP is displaced by air from the cutter, which rounds and bends the melting edge of the part. Delrin has a lower 
degradation temperature (321⁰C) than PP (433⁰C). Delrin also has C-O bond meaning it easily absorbs the energy 
required to vaporize. Despite its lower thermal conductivity (0.1-0.23 W/mK) and heat capacity (1.62 J/K cm3) 
compared to Delrin (0.23-0.37 W/mK and 2.1 1.62 J/K cm, respectively), the PP sample has more melt. Perhaps in 
this case, thermal conductivity and heat capacity play a smaller role than the absorbance of the 940  cm-1 by the C-
O bonds in Delrin. 
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What is this book?

This handbook was written by Annie Zeng, Ingrid 
Hagen-Keith and Mary Morse. Throughout the 
semester, we will be producing a set of laser cutting 
handbooks. The handbooks will touch upon basic 
topics, like how to create proper cut files and 
cutting with the specific laser cutters in the machine 
shop. They will also present more advanced topics, 
such as laser cutter-specific alternative joinery and 
cutting exotic materials. 

This issue is targeted to new and developing laser 
cutting students. It briefly presents various topics 
involved in laser cutting. For more advanced 
discussions of these topics, read our future issues!

This is prototype 1 of our Trainee Handbook. We 
understand that it is not perfect, and we want your 
help to make it better. Please, read through this 
book, ask us questions, mark it up and give us 
feedback! Email the NINJAs at laser@lists.olin.edu. 



Rough Table of Contents

The following list is the rough table of contents for 
this issue:

1. Cut Files
2. Cutting
3. Machines
4. Materials
5. Joints

The purpose of each section is to briefly introduce 
beginner concepts.



Safety

The laser cutter is a printer that can set your stock on fire and 
cause excessive flare-ups. In practice, the laser cutter is as 
safe to operate as any other machine in the shop if common 
sense, vigilance, and thorough training is internalized and 
practiced. The machine should be used and maintained with 
respect to promote safe usage. 

LASER SAFETY

FIRE SAFETY

The Epilog and Trotec Laser Systems contain two lasers.
They both enclose a class 4 CO2 laser which emits intensive 
and invisible laser radiation. These lasers can start fires, 
cause damage to the skin, and are a hazard to the eye when 
viewed directly and from reflections. The second laser is a Red 
Dot Pointer which is considered safe if it is not viewed directly 
or through reflections.  

Make sure you have easy access to and know how to operate 
the fire extinguisher before you execute any cut, especially 
with a new material. Do not ever walk away from a machine 
when it is executing a job. 

FUME SAFETY
Make sure the air exhaust is open and functioning. If you 
see or smell excessive fumes during cutting, stop the job 
immediately.



CUT FILES
Creating cut files for a laser cutting is pretty straight 
forward once acquainted with each software. In the 
following pages, we will outline the file creation 
methods for SolidWorks and Adobe Illustrator.

To improve further improve your skills, we suggest 
reading each machine’s manual and a good 
amount of practice. Consult a NINJA or email 
lasers@lists.olin.edu for more advanced questions.



FILE CREATION IN SOLIDWORKS



 STEPS
1) Model your parts with the appropriate tolerances.
2) Make a new custom drawing file that is the size of the laser 
cutter bed or smaller (just keep track of the size of your cut 
file).
3) Place your parts on the cut file with the view you want 
to laser cut. Do not overlap a part corner with the corner 
of a sheet. Do not import annotations. There should be no 
centermarks or centerlines in your drawing. Outlines of parts 
should be solid lines.
4) Ensure that hidden lines are removed.
5) Ensure that the scale of your parts is 1:1. This may involve 
a custom scale.
6) There should be at least 2 mm distance between parts.
7) Set the line thicknesses to 0.002 inches for vector lines. If 
the cut file includes only vector cuts, use the following steps 
to set up the file: Options-> Document Properties-> Line 
Thickness-> Set all line thicknesses to 0.002 in.-> OK

Tricks of the Trade
Rastered text can be placed into a drawing file using the 
Note button.

Vector cut text must be included at the part level: 
Sketch-> Text-> Select a curve that the text will be on and 
type->Extrude Cut-> All Bodies.

You can insert a picture into a SolidWorks drawing file 
using Insert-> Picture. You can then place the picture 
based on co-ordinates or grabbing.



FILE CREATION IN ADOBE 
ILLUSTRATOR



 STEPS
1) Make a new Illustrator file that is the size of the laser cutter 
bed or smaller (just make sure you keep track of your sheet’s 
dimensions).
2) Draw your parts using the line or pen tool. Do not overlap 
a part corner with the corner of a sheet. Ensure that the 
anchors of the lines are connected.
3) Ensure parts are 2 mm apart.
4) Set the stroke for desired vector cut lines to 0.002 in. If you 
want a rastered line, the stroke must be greater than 0.002 
in.

Tricks of the Trade
For rastered text in Illustrator, just type and place as you 
please. 

If you want to vector cut text, type your text. Then set the 
fill to empty and set the stroke weight to 0.002 in.

Convert images to greyscale so that your have an idea of 
what the rastered image will look like. Black sections will 
be darker than lighter grey sections. White will be rastered 
extremely lightly as a set of light dots.



MACHINES
The machines in the shop are carefully maintained 
and should be treated with absolute respect. That 
being said, they are tools with an enormous 
capacity to do amazing things. This section 
describes how to print the most basic files. For 
more information, read the manual or experiment! 



PRINTING ON THE EPILOG

The Epilog Legend is a powerful laser cutter ideal for 
experimentation with a high level of control. It can 
accommodate stock that is 32 in. x 20 in. The z-axis 
spans 9 in. 

This laser cutter vector cuts or rasters based upon line 
thickness. Lines that are 0.002 in. or less vector cut while 
lines with a greater thickness will raster.

If you wish to increase the speed of your job, make the 
drawing file smaller. Just make sure you follow step 1!

To increase mastery on this laser cutter, read the Color 
Mapping section from the manual. 



 STEPS
1) Ensure that the resolution and scale are properly 
configured using: File-> Page Setup-> Set Scale to 100%.
2) If using the machine shop computer, double check that the 
line thickness are what you intended in your original cut file. 
3) You may then proceed with the printing process: File-> 
Print. Choose AC104L01 as the desired printer. The number 
of copies will always be 1 copy.
4)Click Properties. This will open the Epilog Driver.

5) Set your piece size to the size of your drawing/Illustrator 
file. Ensure you have the correct job type. Please refer to the 
material sections in this book and “Safely experimenting with 
laser cutter settings” for more in-dept settings information.
6) Press Print. The Epilog will receive the order. Using the 
toggle wheel, select Jobs->View. Give the laser cutter a 
minute when doing this. If you can see your cut file, then 
press Jobs->Run. This will run the job with the settings you 
sent at the computer level. (See Focus section to get the ideal 
cut).



PRINTING ON THE TROTEC

The Trotec Speedy 300 is a straight-forward, intuitive 
machine with custom driver software conducive to 
creative manipulation. It can accommodate stock that is 
29 in. x 17 in. The z-axis spans ~8 in. 

This laser cutter vector cuts or rasters based upon line 
color. Lines with a RGB of 0, 0, 0 will vector cut while 
lines with an RGB value of 255, 0, 0 will raster. 

Note that these RGB values must be used! If the numbers 
are even slightly off, the job will not print as you expect.

When creating cut files for this machine, your piece size 
should be limited to 28 in. x 16 in. 



 STEPS
1) Ensure that the resolution and scale are properly 
configured using: File-> Page Setup-> Set Scale to 100%.
2) If using the machine shop computer, double check that the 
line colors are what you intended in your original cut file. 
3) You may then proceed with the printing process: File-> 
Print. Choose the Trotec printer. After pressing OK, the Trotec 
settings driver will open.
4) The settings driver will allow you to set the size, material, 
and settings. You will usually want the Process Mode to be set 
to Standard.
5) If your job involves rastering and vector cuts, you will want 
to set Halftone to on. If it involves only vector cuts, you should 
set the Halftone off.
6) In general, you will always want Cut Line set to None. See 
the Trotec manual if you want more information on this.
7) After all this, press OK. This will open the Trotec job control 
panel.
8) Drag and drop your job from the jobs queue into the 
workspace. To view your job’s lines, click the checkbox at the 
bottom of the Jobs panel. 
9) Note that on the Trotec, you move the head using the 
panel on the machine. The position of the laser head can be 
seen on the Trotec Jon Control software as well. This means 
that you can move the laser head to a specific location on 
your material and then drag and drop the job to snap with 
the laser head cross hatch. So exciting!
10) Connect with the laser cutter and then laser cut away 
after pressing Run.



CUTTING
Laser cutters are more advanced than a 
simple printer that you press and go. Through 
manipulation of setting and setup like 
speed, power, frequency/resolution, focus, kerf, 
and jigging, you can cut a variety of complex, 
exciting jobs like the Mary’s pumpkin above.

This section will help you start thinking about laser 
cutting and settings creatively. The best way to 
learn is through thoughtful experimentation. 



SAFELY EXPERIMENTING WITH 
SETTINGS

The laser cutter is a fantastic prototyping and manufacturing 
method. It gives a high level of control and is very user-
friendly. That being said, there are dangers to using the laser 
cutter. Harmful fumes and particulates may be produced in 
the process of cutting and a fire could be started.

Fires do occasionally happen in the shop and it should not 
be a source of shame if they occur. They can be extremely 
dangerous, damaging to the laser cutter,  and ultimately huge 
pain.

However, this should not preclude individuals from 
experimenting with the laser cutter. Experimenting should 
be done intelligently and with care. In the following pages, 
we will conceptually explain speed, power, and frequency/
resolution. Once you understand these settings, it will be 
easier to think about setting experimentation in a safer 
manner than mere guessing.

A laser cutter is an energy transfer method that can be 
used to melt, vaporize, or degrade a material. You can vary 
how long energy is transferred to a section of a material 
(speed), how much energy is transferred to a section (power), 
and the spacing of the energy transfer to the material 
(frequency or resolution for vector cuts and raster engraving, 
respectively). There are other ways to vary energy transfer but 
these are the most central to laser cutting.



 SPEED
Speed indicates how fast the laser head moves. Lower speed 
allows more time for the laser beam to dwell on a particular 
spot which means more energy is transferred to the material. 
On the other hand, higher speed results in less time for 
the laser beam to apply a certain amount of energy on a 
particular spot on the material.

Speed is measured in m/min and is often expressed as %. 
Maximum speed differs for each type and model of laser 
cutter machine.

To reduce edge modifications like charring and thermal 
damage, you want to increase the speed so that the air assist 
can quickly access the recently cut zones.

Low Speed High Speed

Use the info-graphic above to help you think about speed 
as a parameter of energy transfer.



 POWER
Power indicates the rate at which energy is transferred in the 
laser beam. 

Power is measured in W, and it is often displayed as a 
percentage (%) of maximum power. Maximum power differs 
for each model of laser cutter.

Lower power applies less energy per pulse on the material; 
higher power applies more energy per pulse on the material. 

In general higher power means deeper cuts than lower 
power. 

Low Power High Power

Use the info-graphic above to help you think about power 
as a parameter of energy transfer.



RESOLUTION (FOR RASTER ENGRAVING)
Resolution indicates the density of pulses (measured in dots/
inch, DPI).

Higher resolutions give clearer and more detailed the prints.

Since each pulse applies the same amount of energy 
regardless of resolution settings, higher resolutions 
deliver energy at a higher density than lower resolutions. 
At particularly high resolutions, the dots printed overlap 
meaning most of the image is printed twice, making for a 
darker, deeper image. 

Low Resolution High Resolution

Use the infographic above to help you think about 
resolution as a parameter of energy transfer.



FREQUENCY (FOR VECTOR CUTTING)
Frequency indicates the number of pulses fired per second 
(measured in pulses fired/second, PPS, or Hz).

The higher the frequency, the denser the dots on each path, 
and therefore the more dense the energy applied on the 
material. 

Both resolution and frequency are similar in that both are 
concerned with the number of pulses fired in an area. The 
major difference between the two is that resolution determines 
the quality of the image clarity or an area of a shape that is 
rastered, while frequency determines the quality of a line.

Low Frequency High Frequency

Use the info-graphic above to help you think about 
frequency as a parameter of energy transfer.



EXTRA FACTORS AFFECTING ENERGY 
TRANSFER AND CUT QUALITY
You can affect the outcome of a cut by also varying other 
conditions:

You can change the number of passes (i.e. the number 
of times you run the same job). This distributes the amount 
of energy necessary to complete a desired job over a longer 
period of time, which can avoid issues like charring or 
incomplete cuts.

As a job is running, you can stop it and focus on the material 
again. This ensures that the energy interacting with the 
material is the most concentrated on the top of the material.

You can mask a material with painters tape. This reduces 
char or melt from spilling onto the material. Note that you 
may have to change the settings between a mask and un-
masked material. Note in the image below that the char is 
only on the tape and not on the final pieces. Hooray!



MANUAL FOCUS - EPILOG

1. Mount the manual focus gauge onto the laser head.
2. First choose the location where you would like to focus. To 

do this navigate to the ‘Service’ on the Epilog LCD. Then 
select ‘Move X/Y’. Now you can use the arrow keys to 
move the laser head. Press Enter to select a location.

3. Now press the ‘Focus’ button and use the knob to jog the 
table up and down. Raise the laser bed until the tip of the 
gauge just touches the surface of your material.

Manual
Focus 

Gauge

Auto 
Focus 
Plunger



MANUAL FOCUS - TROTEC

1. Hang the focus gauge from the ledge on the   
laser head.

2. Raise the material using the up and down arrows until 
the tip of the focusing tool just touches the surface of the 
material.

Focus 
Gauge



KERF

Kerf is the width of the cut made by the laser. It changes the 
finished size of your cut piece. If you are designing something 
with very tight tolerances you may want to adjust for the kerf. 
Kerf width changes with every cut, so it is important to take 
new measurements each time you are going to adjust.

Cut Edge
Cut File 

Effect of Kerf

Holes get larger Outer edges move inward

Kerf 
Width



ADJUST FOR KERF

Cut a test square Measure the square piece and 
the hole it left behind in the 
stock

The kerf width can be measured as the difference between 
the outer and inner measurements taken. Compensating for 
kerf is easy. Just add or subtract half the kerf width from the 
edges of your cutfile.



JIGGING AND FIXTURING

LIGHT MATERIALS

WARPED MATERIALS

Thin, light materials should be taped down or secured with 
heavy objects at the edges to ensure that the air vent does not 
move the piece around while a job is running. Materials that 
tend to shift around in the bed can also be secured creating 
a negative mold (e.g. a circular cutout on MDF to hold a 
circular dog-tag). 

Warped materials are difficult to machine because the laser 
cutter cannot dynamically adjust its focus to compensate for 
thickness changes in material. This might be less of a prob-
lem for materials with a greater tolerance for the range of 
focus, as plastics. However, always try to smooth out warped 
objects before cutting or reduce curvature by weighing sec-
tions down with heavier objects. Either manually focus on the 
mid-plane between the maximum and minimum heights of 
the stock or refocus when you get to the warped section. 



CYLINDRICAL OBJECTS

IRREGULARLY-SHAPED OBJECTS

Cylindrical objects can 
be fixed and machined 
via an additional rotary 
device which is secured 
into the laser bed. 

Credits: Epilog

Custom jigs may need 
to be created for irreg-
ularly shaped objects. 
Luckily, you have access 
to a laser cutter, which 
is great for making 
a quick, cardboard 
fixture. 

Credits: Mary Morse



MATERIALS
The laser cutter focuses primarily on cutting 
planar stock. Laser cutter can cut a variety of 
materials at a maximum thickness of about 1/4”. 

You cannot cut thick sheet metal, polycarbonate, 
vinyl, or PVC on the laser cutter as these materials 
produce toxic gases and can damage the machine. 

This section introduces the common laser cut 
materials at Olin and discusses special techniques.



MATERIAL: ACRYLIC

• A transparent thermoplastic polymer. 
• There are two main types of acrylic: extruded and cast 

which differ due to manufacturing technique. Extruded 
acrylic is often more even in thickness across the sheet 
than cast. 

• Machines via vaporization. 

Tips & Tricks: Engraving Acrylic (Extruded vs. Cast)

• Use cast instead of extruded acrylic for rastering to have 
greater image contrast. Cast acrylic rasters to a frosted, 
white appearance. 

Fig. 1Engraved cast acrylic 
sign. Fig. 2 Intricate cut on 
acrylic. Then thermoformed to 
induce curvature. 

Credits: Fig. 1 Epilog; Fig. 2 
Danger Awesome

2

1



Tips & Tricks: Vector Cutting Acrylic

• A glistening melt edge can be achieved on acrylic by 
vaporizing instead of melting the material. Use a high 
frequency/power and low speed combination to provide 
more energy to the cut zone. The shiny edge is a result of 
re-solidified melt, which reduces the mechanical integrity 
of the material. 

• Unwanted markings (flashback) can occur on the back of 
your acrylic piece when it is cut directly on the metal bed. 
The excess laser energy is reflected off of the aluminum, 
onto the material. Avoid flashback by raising the stock a 
few inches above the bed before cutting. 

• When engraving large areas of acrylic, fine horizontal 
lines from the scanning laser beam can make the image 
look grainy. Shift the piece from the optimum focus level 
by ~1.6mm so that the size of the beam is increased to 
achieve a  blending effect. 

• Flip the image of your raster file to engrave on the 
bottom of the material in order to view the image through 
the transparent piece. 



ACRYLIC SETTINGS

Epilog 75W 32EX Legend

R or V? Thickness Speed Power DPI/Freq

R All 100 30 600
V 1/8” 25 100 N/A
V 15 100 N/A
V 3/8-1/2”

3/8-1/2”
6 100 N/A

Comments

R or V? Thickness Speed Power DPI/Freq Comments

Trotec Speedy 300



MATERIAL: DELRIN

• An opaque engineering thermoplastic material 
• Ideal for laser cutting high precision, low friction parts 
• Laser machined by vaporization of material similar to 

acrylic due to its low vaporization point. 

1 2

3 Fig. 1Rougher edges created by manipulating 
frequency allow friction hold. Fig. 2 Raster im-
age contrast is provided with dry-erase marker 
blotting. W. 3 Laser-cut delrin can be used for 
high precision, low friction gears

Credits: Fig. 3 http://www.ulsinc.com/material-profile/delrin#prettyPhoto; 
Fig. 2 http://www.built-to-spec.com/blog/2012/05/12/adding-colored-etch-
ing-to-laser-cut-parts/; Fig. 1 http://makezine.com/2010/01/14/letters-from-
the-fab-academy-part-1/ 



Tips & Tricks: Engraving Delrin

Tips & Tricks: Vector Cutting Delrin

• Laser cut edges of Delrin are consistently smooth and 
have reasonable dimensional stability. Material should 
be machined at a high frequency/power and low speed 
combination similar to acrylic. 

• It is important to place a material layer below Delrin or to 
prop it on a stand when vector cutting; otherwise, flash-
back (see acrylic) will occur on the underside of the stock.

• Delrin is a slippery material. A rougher surface finish can 
be induced on your parts by decreasing the frequency of 
the laser cutter to create “teeth-like” features on cut edges 
for friction holds. 

• Engraved delrin is always white. Engraved white delrin 
provides little image contrast. If more contrast is desired, 
the rastered area can be blotted with a colorful dry-erase 
marker. Prototype with this technique before finalizing 
designs. 



DELRIN SETTINGS

Epilog 75W 32EX Legend

R or V? Thickness Speed Power DPI/Freq Comments

R or V? Thickness Speed Power DPI/Freq Comments

Trotec Speedy 300



MATERIAL: MEDIUM DENSITY 
FIBREBOARD (MDF)

• A wood-composite combined with wax and resin under 
high temperatures and pressures. 

• More homogeneous and therefore easier laser-machined 
than natural woods.

• Cut by chemical degradation (combustion), leaving a 
black carbon residue upon laser heating. 

Fig. 1-3 3D mode. Fig. 4 
Depth rastering on MDF

Credit Fig. 1: Epilog 

1 2

4 3



Tips & Tricks: Engraving MDF

Tips & Tricks: Vector Cutting MDF

• Thinner sheets of MDF can be cut through with a single 
pass. However anything above ~3mm (~1/8”) is best 
machined with multiple passes to improve cut quality. 

• Soot which collects on the cut edges can be removed with 
a dry towel that does not leave fibers on the material, or 
even better with a chamois cloth or eraser. 

• Similar to engraving MDF, it is useful to mask the mate-
rial before vector cutting to reduce surface build-up of 
residue. 

• Engraved MDF discolors to an orange-brown which gets 
darker with increasing laser energy density. Mask the ma-
terial to avoid surface residue from resin and adhesives 
released from the material upon heating. 

• MDF engraves really well with grayscales and in 3D 
mode if your laser system possesses this setting. Great 
variation in height and color result. 



MDF SETTINGS

Epilog 75W 32EX Legend

R or V? Thickness Speed Power DPI/Freq Comments

R or V? Thickness Speed Power DPI/Freq Comments

Trotec Speedy 300



MATERIAL: CORRUGATED CARDBOARD

• A wood-based composite material made up of layers of 
corrugated paperboard.

• Mainly used for packaging and shipping.
• Since cardboard is a widely available material, it is ideal 

for quick prototyping.
• Since wood fibers have a burning point that is much 

lower than their melting temperature, cardboard is laser 
machined by chemical degradation. 
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Fig. 1Direction of cardboard 
flutes creates aesthetic effect. 
Fig. 2 Lunch box of cardboard 
layers. Fig. 3 Selective removal 
of cardboard layers. 



Tips & Tricks: Vector Cutting Cardboard

• Laser cut edges of corrugated cardboard will be have 
some residual carbon leaving the edges a dark brown or 
black color. This will be difficult to eliminate entirely, but 
may be reduced by fine tuning the settings.

• The precision of the laser cutter allows you to select the 
individual layers which you cut through. You can vector 
cut a pattern out of the top layer of the corrugated card-
board, then selectively peel away certain parts. Wetting 
the top surface of the corrugated cardboard with a Q-tip 
may make peeling it away cleaner and easier. When 
peeled away dry, the material has a tendency to tear and 
leave small pieces that make the finished product look 
messy.



CARDBOARD SETTINGS

Epilog 75W 32EX Legend

R or V? Thickness Speed Power DPI/Freq Comments

R or V? Thickness Speed Power DPI/Freq Comments

Trotec Speedy 300



JOINTS
Through a combination of woodworking and 
laser cutting specific joints, you can create 
beautiful and mechanically sturdy structures and 
mechanisms, like Annie and Ingrid’s lantern. 

This section showcases three beginner joints: 
the slot, finger, and mortise and tenon joints. Get 
inspired by joints by exploring what the internet 
has to offer and examining woodworking or plastic 
joinery methods!



SLOT JOINTS
The slot joint is a very simple joint to design and construct. 
Finished pieces are assembled by sliding into slots at right 
angles to one another.

T
T

The only crucial dimension is the width of the slot, T, which 
corresponds to the thickness of the material being used.



FINGER JOINTS
Finger joints are a simple way to join two perpendicular 
pieces of material at an edge. The joint can be secured by 
using

T W

D

W

D T

W - Width of finger
D - Distance between fingers
T - Thickness of material



MORTISE & TENON
The mortise & tenon allows you to attach two pieces of 
material at a right angle to form T shaped joint. The joint 
is often glued or press fit to create a strong, permanent 
connection.

W - width of mortise
D - Distance between mortises
T - Thickness of material

T

W

W

T

Mortise Tenon

D

D



ADDITIONAL RESOURCES
• Epilog Legend 32x Manual: http://www.epilogfiles.com/

extt_manual.pdf 

• Trotec Speedy 300
• Software manual: http://www.troteclaser.com/en-US/

Support/Documents/JobControl-Manual-EN.pdf
• Laser System manual: http://www.troteclaser.com/en-

US/Support/Documents/Speedy-300-Manual-EN.pdf

• CO2 Laser Cutting by John Powell

• LIA Guide to Laser Cutting by the Laser Institute of Amer-
ica

• For inspiration: 
• TLC: http://thelasercutter.blogspot.com/
• Pinterest, MakeZine & Instructables
• Laser Brothers Facebook Page
• Snijlab: https://www.snijlab.nl/en/p/29/examples
• University of Buenos Aires, Morphology and Digital 

Fabrication Lab: http://workshopmyt.blogspot.com/
• University of Minnesota, College of Art: http://blog.

lib.umn.edu/artdept/lasercutter/



BRAINSTORMING & FEEDBACK



MAINTENANCE

Maintenance is possibly one of the most significant aspects to 
laser cutting. A poorly kept machine and work area reduce 
cut/engraving quality and increase the likelihood of a fire 
hazard. 

Clean-Up Checklist
All WIPE-DOWN procedures should be done with a wet 
paper towel, Windex, or isopropyl alcohol. 

1. WIPE DOWN the periphery of the laser bed (ruler area). 

2. WIPE DOWN the auto-focus plunger. 

3. The external optics system can incur a build-up of debris 
from excessive flare-ups. This can reduce the quality of 
the cut produced. ONLY clean the mirror and focus lens 
if you have been trained to do so. If not, inform someone 
in the shop of the debris/residue. 

4. REMOVE any small, residual pieces of stock from the 
cutting bed left from the job. 

5. EMPTY the crumb tray. 

6. REMOVE clutter around the machine to keep the area 
clear of combustible materials. 



Wait! Before you cut, 
did you?
• Test your settings?
• Measure the kerf?
• Fix material securely to the bed? 
• Focus?
• Turn on air filters/ ventilation?

Got a question or feedback?
Email the NINJAs at lasers@lists.olin.edu
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Fundamentals

Snap-fit Joints & Compliance

The contrast in these two operations can be seen in the printer-like dot pattern 
generated by rastering and the vertical ripples due to the pulsing frequency of 
the laser while vector cutting. 

A snap fit joint is a compliant mechanism that works by 
briefly deflecting the protruding part of a piece so that it 
catches in a depression in another piece.

Compliance refers to a structure’s ability to briefly bend or 
twist and then return to its original orientation. It relies on 
the material’s elastic properties.

What is the difference between vector cutting and raster 
engraving?

Fig. 1 Juxtaposition of vector cutting and raster engraving on cast acrylic. Jobs 
were done on a 60W Epilog Helix. Vector settings: S/P/F 20/100/5000. 
Raster settings: S/P/DPI 100/30/600. Images were taken with an optical 
microscope at 5x magnification.

Vector cutting is an operation used 
to pierce or score a material with the 
laser cutter. When it is compared to 
operations on traditional CNC tools as 
the manual mill, it is akin to profiling. 

Raster engraving is an operation 
used to bring the thickness of the 
material down in depth. It is akin 
to facing on a vertical knee mill. 
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LIA Guide to 
Laser Cutting 
by the Laser 
Institute of 
America

CO2 Laser 
Cutting by 
John Powell

Recom
m

ended Resources

Handbook 
of Complian 
Mechanisms 
by Larry 
Howell, 
Spencer 
Magleby, & 
Brian Olsen.

What is a snap-fit joint?

How do you effectively design a snap-fit joint?

How do snap-fit joints work?

You want your snap fit joint to be strong enough to effectively hold together 
your structure and withstand loads. However, you also need your snap fit joint 
to be flexible enough to deflect the appropriate amount without snapping off 
the finger. 

Given this, we suggest the following rules of thumb when designing your snap-
fit joints:
1) Having two wide (L1), deep (S1) valleys beside the finger reduces the chances 
of material breaking and allows for compliance in both directions
2) A very thin finger (L2) will be more flexible but less snug
3) S2 should equal the thickness of the interfacing material (see the example 
pieces)
4) Ensure that the angle (A) is large, otherwise the finger will over-bend and 
snap as it is engaged

Most snap-fit joints are simple 
cantilever snaps. A cantilever is a beam 
that is anchored on one end. Cantilevers 
easily support forces applied to its 
length by bending i.e. redirecting the 
load to the supported end.
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